
November 5, 2001 Embedix GPL Compliance Toolset Lineo 1.04b





November 5, 200
Embedix
GPL Compliance Toolset 
User Guide
1 Embedix GPL Compliance Toolset Lineo 1.04b



November 5, 2
Disclaimer

No Warranty:  Licensed products are provided under this license on an “as 
is” basis, without warranty of any kind, either express or implied, including 
without limitation, warranties that the licensed products are free of errors, 
merchantable, fit for a particular purpose or non-infringing. Specifically, 
use of the licensed products does not guarantee legal compliance with any 
license, including but not limited to the GNU General Public License. 
Neither the licensed products, nor any results or outputs thereto, constitute 
legal advice. Use of the licensed products is not a substitute for legal review. 
The entire risk as to the quality and performance of the licensed products 
is with you. This disclaimer of warranty constitutes an essential part of this 
license. No use of any licensed product is authorized hereunder except 
under this disclaimer.

Limitation on Liability: Any use of the licensed products and/or reliance on 
the results or outputs of such licensed products shall be at your own risk 
and liability. In no event shall Lineo be liable for any direct, indirect, 
incidental, special, exemplary, or consequential damages (including, but 
not limited to, loss of use, data, or profits, or business interruption) 
however caused and on any theory of liability, whether in contract, strict 
liability, or tort (including negligence or otherwise) arising in any way out 
of the use of, or reliance on the results or outputs of, the licensed products, 
even if advised of the possibility of such damage.

Trademarks

Lineo is a registered trademark of Lineo, Inc. The Lineo “Swirl” logo and 
Embedix are trademarks of Lineo, Inc. 

Other product and company names mentioned in this document may be 
the trademarks or registered trademarks of their respective owners.

Copyright © 2001 Lineo, Inc. All rights reserved. No part of this publication 
may be reproduced, photocopied, stored on a retrieval system, or 
transmitted without the express written consent of the publisher.

Lineo, Inc.
390 South 400 West
Lindon, UT 84042
USA 

http://www.lineo.com

Embedix GPL Compliance Toolset User Guide
Part Number: EMBD-SDK2.0GPLCOMP-UG-1001
October 2001
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P R E F A C E

About This Guide
Conventions Used in This Document
The style conventions used in the printed and PDF format of this 
document do not necessarily apply to other formats. During 
conversion to HTML, some of these conventions may be lost.

This document uses the following graphical and typographical 
conventions:

! Admonitions

! Key combinations

! Special fonts and capitalization

Admonitions

Note, Tip, and Warning paragraphs draw your attention to additional 
information which may help you avoid losing data or time.

Note:  Notes contain additional information about the 
current topic.

Tip:  Tips contain suggestions that may save you time or 
effort.

Warning:  Warnings contain critical information that you 
need to understand before proceeding. Ignoring 
information in a warning may cause loss of data or time.
Preface: About This Guide iii

1 Embedix GPL Compliance Toolset Lineo 1.04b



Conventions Used in This Document

November 5, 2
Key Combinations

Key combinations (such as Ctrl+O) are presented throughout this 
document and should be used in the following way:

1. Press and hold the first key.

2. Press the second key.

3. Release both keys.

For two-step key combinations, repeat the pattern. For example, to 
execute the key combination Ctrl+Q Shift+Q, do this: 

1. Press and hold the Ctrl key.

2. Press the Q key.

3. Release both keys.

4. Press and hold the Shift key.

5. Press the Q key.

6. Release both keys.

Special Fonts and Capitalization

Two special fonts have been used to distinguish between user input 
and computer output:

! Command

All commands or data to be entered on an on-screen data entry 
line appear in bolded Courier font. This may include 
commands used with options, paths to directories or files, or 
other simple input, such as filenames.

! Code

Any code sample, including command output, is shown in 
Courier font.

The following capitalization rules apply to Linux filenames, Linux 
commands, and English names of on-screen buttons and keyboard 
keys.
iv Embedix GPL Compliance Toolset
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! Linux filenames and commands are case-sensitive. In most 
instances, they are lowercase. When you enter a filename or 
command, use the same case that appears in your instructions 
or examples.

! When procedures refer to a particular on-screen button, the 
name of the button appears in uppercase (such as in SAVE), 
regardless of how it appears on the screen.

! When procedures refer to a particular key on a keyboard, only the 
initial key is capitalized (such as the Tab key), just as it appears 
on a U.S. standard keyboard. This also applies to key 
combinations.

Additional Resources
The following resources are available to provide you with additional 
support. 

! Embedix SDK Getting Started

! Embedix SDK Target Wizard User Guide

! Embedix SDK Reference Manual

! Embedix RealTime Programming Guide

! Lineo™ Support Web site

http://www.lineo.com/support

Note:  Most printed manuals that ship with Lineo products 
are also available in PDF and HTML formats on the product 
CD-ROM and the Lineo Web site.
Preface : About This Guide v
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C H A P T E R 1 Getting Started
This document provides an introduction to the Embedix GPL 
Compliance Toolset. Topics covered in this document include:

“Host Requirements” on page 1
“Introduction to the Tools” on page 2
“Installing the Toolset” on page 3

Host Requirements
This toolset is intended for use on your Linux development host 
machine that is already running Embedix SDK. 

Hardware

! 64 MB RAM minimum (128 MB or greater recommended)

! Pentium processor minimum (Pentium II/K6, 400 MHz or 
greater recommended) 

! In addition to the Embedix SDK disk space requirements (refer 
your Embedix SDK documentation), provide another 300 K disk 
space for this product.

Software

! A Linux operating system from a supported distribution (such as 
Caldera OpenLinux, Red Hat, or SuSE).

! Embedix SDK 2.0 or higher

! Embedix GPL Compliance Toolset (this product)
Chapter 1: Getting Started 1
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Introduction to the Tools
Embedix GPL Compliance Tools is a product designed to provide 
analysis and assistance that will help you identify risks of GPL 
contamination in your company’s software. The tools will assist you 
in complying with the GPL and other licenses used with open source 
software.

This toolset is designed to be installed on top of Embedix SDK 2.0 or 
higher. After installation, these tools are easily accessed from the 
Target Wizard menu bar. The tools included are:

! Library Checking Wizard

! License Reporting Wizard

! License Compliance Interview 

Warning:  Use of this product cannot guarantee absolute 
GPL compliance because the accuracy of the tools in this 
product depends heavily on the accuracy of your answers.

Library Checking Wizard

This tool scans target executables and finds out which software 
licenses may apply to them by looking at what libraries executables 
link to. It also scans makefiles of applications to try to determine the 
same information for libraries that are linked statically.

License Reporting Wizard

This tool analyzes all of the software for a project and then prepares 
a detailed report of the software licenses that are included in the 
project.

License Compliance Interview

This tool asks developers about their development practices, source 
code habits, library usage, and so forth, in order to determine if their 
software is legally GPL “clean.”
2 Embedix GPL Compliance Toolset
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Installing the Toolset
1. Log in to your Linux desktop as root.

2. Open a terminal emulation window.

3. Insert the Embedix GPL Compliance Toolset CD-ROM in the 
CD-ROM drive.

If the CD auto-mounts, skip to Step 5.

4. Mount the CD-ROM by entering the following command:

mount /mnt/cdrom -o exec

5. Change to the directory for the CD-ROM mount point:

cd /mnt/cdrom

6. Run the installation script:

./install.sh

The following messages appear as the installation begins:

Wizard Installation Complete.

Starting the GUI Install.

Progress windows appear indicating installation activity.

7. At the Finish page, click FINISH.

8. When you are returned to the terminal emulation window, log 
out of the desktop as root.

The next time you log in as a regular user, you can easily access 
the tools in this product from the Target Wizard menu bar (see 
the File > Run Wizard menu item).
Chapter 1: Getting Started 3
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C H A P T E R 2 Library Checking Wizard
The Library Checking Wizard, like the other tools in this product, is 
accessed through the Embedix™ Target Wizard File menu. This 
chapter includes the following sections:

“Introduction” on page 5
“Starting the Library Checking Wizard” on page 6
“Using the Library Checking Wizard” on page 7
“Using the Library Checking Wizard with Third Party or In-

house Libraries” on page 13

Introduction 
The purpose of the Library Checking Wizard is to help software 
developers and Embedix SDK users understand how linking with 
libraries may affect licensing issues with regard to their software. 

This tool performs two main functions:

! It can scan a filesystem and collect information from all of the 
shared libraries and executables and give a listing of which 
libraries are used by which executables and give the license for 
each library used. 

! It has the ability to scan a source tree and examine makefiles to 
determine which libraries will be linked with the executable. 
This allows the tool to find all libraries linked to the executable 
even if the libraries are statically linked. 

In both cases, the wizard can list the licenses associated with each 
library used and tell if the software will be subject to any restrictions. 
This can help software developers make sure that their intellectual 
property stays free of any licensing restrictions due to library usage. 
Chapter 2: Library Checking Wizard 5
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Starting the Library Checking Wizard
To start the Library Checking Wizard: 

1. Using Target Wizard, prepare your project for analysis.

Use your Embedix SDK documentation set as needed to 
complete the following subtasks:

1a. Start Target Wizard and open the project you want to 
analyze. 

1b. Modify the project if needed by enabling/disabling nodes in 
the tree view. 

1c. Build the project by choosing the Build > Build menu item. 

Target Wizard will build all of the files needed for your 
project. This may take a few minutes depending on your 
project settings.

1d. Build the filesystem by choosing the Build > Deploy menu 
item and proceeding through the next few wizard pages until 
the project filesystem has been built, then click OK and then 
CANCEL to exit the wizard. 

You do not need to actually deploy the filesystem anywhere. 

2. From the menu bar, choose File > Run Wizard. 

A dialog box similar to this one will pop up with a list of wizards. 
6 Embedix GPL Compliance Toolset
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3. Highlight Library Checking Wizard in the list and then click 
RUN. 

The first page of the Library Checking Wizard appears. 

Using the Library Checking Wizard 
Navigation 

You can navigate the Library Checking Wizard by clicking on the 
NEXT and BACK buttons. Each page will have instructions 
describing its purpose and what you need to do at the top. Most 
pages will also have an enabled HELP button that you can click to 
display more in-depth instructions and assistance. You can click 
CANCEL at any time to exit the wizard. 

Usage 

When you first start the wizard, a page appears with instructions and 
an explanation of what the wizard will be doing. When you click 
NEXT, the wizard will build a database of file and license 
information. This process may take anywhere from a few seconds to 
a couple of minutes. 
Chapter 2: Library Checking Wizard 7
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Reports 

The second page shown allows you to pick the type of report that you 
want to generate and view. Both reports contain some information 
about library usage and allow you to analyze licenses usage. 

You can view either report in a text window and have the option to 
save it as a text file for use at a later time. 

! Dynamic Library Usage Report - This will scan the filesystem 
that has been built for your project and display information 
about which shared libraries are being used and what their 
licenses are. 

! Source Code Report - This will scan a source code tree and 
analyze makefiles to determine both dynamic and static library 
usage. 

Select the report that you want to view and click Next. 

Dynamic Library Usage Report 

Use this report to evaluate executable files to determine which 
dynamically shared libraries are in use. 

If you chose to view the Dynamic Library Image Report, then the 
report displays in a text window on the next page. 
8 Embedix GPL Compliance Toolset
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This report is divided up into three main sections.

The first section contains a listing of all executables and shared 
libraries that the wizard found in the filesystem that was built for 
your project. Below each executable's name is a list of libraries that 
the executable links to dynamically at run time. This allows you to 
very easily determine if a given executable (or library) links to a 
certain library that may have licensing restrictions. 

The second section contains a listing of all shared libraries found in 
the filesystem. For each library, a list of all executables and libraries 
that use it is given below its name. This can be useful if you know 
that a certain library has a restricted license (e.g. the GPL) and want 
to see which executables use that library and would be subject to the 
license. This may also help you to determine if some libraries are not 
being utilized or only being used by executables that are not essential 
to the project. 

The third section of the report gives an exhaustive list of all shared 
libraries found, which license they use, and an indication as to what 
legal restrictions accompany their use. If a library is marked as being 
safe to link against, then anyone can link to it without worry that the 
resulting executable may legally fall under licensing restrictions. The 
wizard may not have information about every library that is found. If 
libraries are added to a project by virtue of the merge directory or if 
the project is using 3rd party or in-house packages that don't include 
Chapter 2: Library Checking Wizard 9
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their license information then the wizard will not have license 
information and it will inform you of that. 

If you would like to save this report to disk for use at a later time, click 
on Next to view the Save Results page and refer to the guidelines 
listed in “Saving Reports” on page 12. 

Source Code Report 

Although it's possible to determine the shared libraries that an 
executable uses by simply examining the executable, it's not possible 
to determine which libraries are statically linked in. The only way to 
determine which libraries are statically used is by looking at how an 
executable is created. 

The Source Code Report is generated by scanning the makefiles in a 
source code tree and examining which libraries are used when 
building the executable. For this purpose, the source code for a given 
package must be available. For any SDK package, you can make the 
source code available by right clicking on the package's node and 
selecting Force Rebuild. This will untar the source and begin a build. 
You don't need to complete the build, just let it get far enough into 
the build process that the source has been untarred. 

The following page appears when you choose the Source Code 
option.
10 Embedix GPL Compliance Toolset
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When you click Next, a source analysis is performed on the source 
location you indicated. Your Source Analysis Report may look 
something like this:

The Source Analysis Report will allow you to specify which directory 
to use as the root of the source tree. 

The default is the project src directory. All Embedix packages are 
built off of this directory. For instance, when ash is built in user 
twuser’s proj_2001 project, it untars the source to: 

/home/twuser/project/proj_2001/src/ash 

You will probably want to select a directory just under the src 
directory of your project, but you are not limited to scanning only 
SDK packages. This tool can actually be pointed at any source code 
tree that you would like an analysis of. Click on the Browse button to 
look through your filesystem for a source tree.

Once you have selected the desired directory, click on the Next button 
and the wizard will scan through the source tree looking for 
makefiles. This process is usually very fast, but depending on the 
size of the sourc code, it may take up to a minute or so. 

The resulting page will display a report containing information 
about the libraries used in the build process for the executable. 
Chapter 2: Library Checking Wizard 11
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The report will contain a list of all of the makefiles that were found 
at the top. Below, for each makefile, a list of the libraries used in the 
makefile will be listed along with the name of the license and a 
phrase indicating how legally safe it is to use that library. 

As with the Dynamic Library Report, it's possible that the wizard 
might not have information about every single library. If there are 
any unknown libraries, the wizard will mark these as unknown and 
will not display license information about them. It is best to look for 
information on your filesystem about these unknown libraries. (If a 
package uses a library then the header files for that library will most 
likely be somewhere on your system and they are likely candidates 
for license information.) 

If you would like to save the report to a file for use at a later time, click 
NEXT to view the Save Report page and then refer to the guidelines 
in the next section, “Saving Reports.”

Saving Reports 

When you are viewing either of the library reports, you can click the 
NEXT button to view the Save Results page. This page allows you to 
save the reports to disk. These reports can then be sent to legal 
counsel, included in documentation, etc. 
12 Embedix GPL Compliance Toolset
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By default, the filename to save the report under is the report name 
with a .txt suffix and the directory is the project directory. Therefore, 
if you wanted to save the source report for a source tree for a package 
in your proj_2001 project, the default path would be: 

/home/<username>/project/proj_2001/source_report.txt 

You can change the path to specify where the file should be saved by 
typing that path into the text box. In addition, you can click the 
BROWSE button to look through your filesystem. The report will 
only be saved if the checkbox labeled Write Reports to a file is 
checked. When you click NEXT, the report will be saved to the file 
that you specify. 

At this point you can click BACK repeatedly to access other parts of 
the wizard or click FINISH if you are done. 

Using the Library Checking Wizard with Third Party or 
In-house Libraries 

The license information about libraries that the Library Checking 
Wizard uses is taken from the ECD files in the Embedix SDK.

If you would like to have the Library Checking Wizard recognize 
libraries from 3rd party or your own SDK packages, you will need to 
add license information to the corresponding ECD files. If you are 
not familiar with ECD files, refer to Embedix SDK Target Wizard User 
Guide, Chapter 3, “Adding a Custom Application to Your Project.”

For detailed information on adding license information to ECD files, 
please read the License Reporting Wizard Documentation. It is 
strongly encouraged that you include license information for all SDK 
packages that are created because this will ensure that these 
packages take advantage of features in other current and planned 
Embedix SDK tools. 
Chapter 2: Library Checking Wizard 13
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C H A P T E R 3 License Reporting Wizard
The License Reporting Wizard, like the other tools in this product, is 
accessed through the Embedix™ Target Wizard File menu. This 
chapter includes the following sections:

“Introduction” on page 15
“Starting the License Reporting Wizard” on page 15
“Using the License Reporting Wizard” on page 17
“Using the License Reporting Wizard with Third Party or In-

house Packages” on page 25

Introduction
There are a number of software packages included in the Embedix 
SDK. These packages use a variety of licenses—some that use 
general licenses and some that use custom licenses and copyrights. 

The purpose of the License Reporting Wizard is to help you 
understand the legal obligations that apply to the packages you use 
and to help you ensure that your product is compliant.

This tool explains the meaning of each license (in plain english), 
generates reports, and creates text files that can be included in 
documentation for a finished product. 

Starting the License Reporting Wizard
To start the License Reporting Wizard for your project: 

1. Start Target Wizard and open the project you want to analyze.

2. Make sure that all of the desired software packages are enabled 
in the project.
Chapter 3: License Reporting Wizard 15
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3. From the menu bar, choose File > Run Wizard.

A dialog box appears with a list of wizards. 

4. Highlight License Reporting in the list and then click RUN. 

The License Reporting Wizard Introduction page appears.
16 Embedix GPL Compliance Toolset
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Using the License Reporting Wizard
Navigation 

You can navigate the License Reporting Wizard by clicking on the 
Next and Back buttons. On each page, instructions will be shown at 
the top describing the purpose of the page and what you need to do. 
Most pages also have a Help button that will display more in-depth 
instructions if clicked. You can click the CANCEL button at any time 
to exit the wizard. 

Usage 

When you first start the wizard, a page appears with instructions and 
an explanation of what the wizard will be doing. Read through the 
text and make sure that you understand it. When you click NEXT, the 
wizard queries the Target Wizard database to see what packages are 
selected. The wizard then reads the license information for each 
selected package and generates a database. This may take anywhere 
from a few seconds to a minute to complete. A progress bar appears 
to visually display the progress. 

On the second page of the wizard you are presented with a list of 
options. 
Chapter 3: License Reporting Wizard 17
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Each option allows you to view license information in a different way: 

" View Licenses - This option will display a comprehensive list 
of all of the licenses that apply to software packages in Target 
Wizard and allow you to view them. 

" View Licenses by Package - This option will display a list of 
all selected packages in your project. You can then select a 
package to view it's license. 

" View Packages by License - This option sorts each of the 
packages in your project by their license. This way you can 
easily see a breakdown of what licenses apply to which 
packages. 

" View Reports - Selecting this option will present you with a 
list of reports that you can view or save to disk. 

" Quit - This option jumps to the last page of the wizard to 
allow you to exit 

1. Choose an option and then click NEXT. 

You can later click BACK to return to the Options menu. 

2. For instructions on how to proceed, see the applicable 
instruction below.

If you chose... Then...

View Licenses Refer to “View Licenses” on page 19.

View Licenses by Package Refer to “View Licenses by Package” 
on page 20.

View Packages by Licenses Refer to “View Packages by License” 
on page 22.

View Reports Refer to “View Reports” on page 23.

Quit At the Finish page, either click 
FINISH to exit the wizard or click 
BACK to return to the Options menu.
18 Embedix GPL Compliance Toolset
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View Licenses 

This view is a comprehensive list of all of the licenses that apply to 
software packages in Target Wizard. This allows you to view licenses 
for packages that may not be turned on in your project. For example:

At the top of the list are a number of common licenses: BSD, GPL, 
LGPL, Artistic, and Lineo. Following these common licenses is a list 
of other licenses sorted alphabetically. Note that this list is not 
exclusive to packages that are enabled in your project. This allows 
you to view the license of a package that you are considering for 
inclusion in your project without having to first enable it in your 
project. 

1. Choose the license that you want to view and then click NEXT. 

On the following page you will see the text of the selected license 
along with some “rules” that apply to this license. These rules 
basically describe the restrictions that need to be followed if you 
use a software package with this license. In essence, if you follow 
these rules, you should be legally covered. 
Chapter 3: License Reporting Wizard 19
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If you select a package that has no license then you will see the 
text “This package has no license.” This means that the package 
you selected is free of any licensing restrictions. 

2. After viewing the license text, click NEXT to finish or BACK to 
view other licenses. To return to the Options menu, click BACK 
twice.

View Licenses by Package 

This view shows the list of the packages that you enabled in your 
project. Next to each package name is a one or two word description 
of the package's license (such as GPL, LGPL, or Artistic). 
20 Embedix GPL Compliance Toolset
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1. Review the package list with the license for each package 
identified.

If the word Unique is next to the package's name, that simply 
indicates that the package does not fall under one of the common 
well known licenses. 

The word None indicates that the package is not subject to any 
licensing restrictions. 

2. To view an applicable license, select a package and then click 
NEXT. 

The text of the selected license appears along with some “rules” 
that apply to this license. For example, if you were choose a 
package with the license GPL (such as “busybox” in our sample), 
then you would see something similar to the following: 
Chapter 3: License Reporting Wizard 21
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These rules basically describe the restrictions that need to be 
followed if you use a software package with this license. In 
essence, if you don’t follow these rules, you subject yourself to 
potential legal risk.

3. After viewing the license text, click NEXT to go to the Finish page 
or click BACK to return to package list. Click BACK twice to 
return to the Options menu.

View Packages by License 

Choosing this option displays a compiled list of packages sorted by 
their licenses. This allows you to quickly analyze the licenses that 
apply to your project visually. 

Each license that applies to your project is displayed with the 
packages that apply to each license listed under each one. 
22 Embedix GPL Compliance Toolset
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Two special exceptions apply to this grouping of licenses—“specific 
licences” and “no license.”

Most likely there will be a group that reads:

“The following packages have custom, package-specific 
licenses.”

Also, there may be a category at the bottom that reads: 

“The following packages have no license. These packages are 
free of any rules or stipulations about their use.” 

You are free of legal obligations for any package found in this list. 

View Reports 

Choosing this option displays a list of three reports that you can view 
and save to disk. The three available reports are: 

! Summary Report - Generate a summary of all the software 
packages in the project and their licenses. This is useful for a 
quick visual overview of the project. 

! Detailed Report - Generate the Summary Report, but include the 
text of all licenses in the report as well. This report can then be 
given to the legal department, etc. 
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! Documentation Report - Generate a report that includes all of the 
attributions and licenses that are required to be included in the 
documentation of a project. This report can then be included in 
the appendix of your product manual, etc. 

To view your report of choice:

1. Select the report that you want to view and then click NEXT. 

The selected report will appear in a text window.

2. Use the scrollbars on the side of the text window to view the 
entire report. 

3. When you are finished viewing the report, click NEXT to have 
the option of saving this report to a file or click BACK to choose 
a different report for viewing. Clicking BACK twice will bring 
you to the Options menu again. 

Saving Reports 

You will likely want to save different reports to a file for use at a later 
time. Clicking NEXT on the page showing the report will allow you 
to save the report to a file. 

1. Check the Write Report to a File checkbox. 

2. In the Enter Report Filename box, enter a filename for your 
report.
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By default, the directory is your Target Wizard project directory 
and the filename is the name of the report with a .txt suffix. 

For example, if your project was named “proj_2001” and you had 
chosen to view the Documentation Report, the filename might 
be: 

/home/<username>/project/proj_2001/

documentation_report.txt 

If you want to change the location where the file will be saved, 
type the new path into the text box provided. 

You can click the BROWSE button to browse through your 
filesystem to help you set a new location.

3. Click NEXT to save the report to location you specified. 

4. Click BACK repeatedly to access other parts of the wizard or click 
FINISH if you are done. 

Using the License Reporting Wizard with Third Party 
or In-house Packages 

The License Reporting Wizard is designed to work with third party 
Target Wizard packages as well as those shipped with Target Wizard. 
Getting your own packages to work with the License Reporting 
Wizard requires a few, simple steps.

Before continuing, you should be familiar with Target Wizard 
package components (such as ECD files and LBC files). If you are 
unfamiliar with how to create or modify ECD files, see the Target 
Wizard User Guide, Chapter 3 (“Adding a Custom Application to 
Your Project”) in the Embedix SDK 2.0 documentation set.

The License Reporting Wizard gathers information from the ECD 
for each package. For this purpose, a new tag has been added to the 
ECD file specification, <LICENSE>. If present in a component node, 
this tag describes the license information associated with that 
component. 

The license tag can be anywhere inside of the component tags for a 
given component. 
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If the license for a particular package is one of the common well-
known licenses then it is sufficient for the data to be the name of that 
license. The list of available common licenses is: 

! GPL 

! LGPL 

! Artistic 

! BSD 

! Lineo 

! None 

Thus if you have some package, hello_world that is licensed under 
the LGPL, the ECD could look something like this: 

<GROUP bar> 

<COMPONENT hello_world> 

        LICENSE=LGPL 

        TYPE=bool 

        DEFAULT_VALUE=1 

        PROMPT=include hello_world package 

        <HELP> 

        This is hello_world. 

        </HELP> 

        <REQUIRES> 

                libc.so.6 

                ld-linux.so.2 

        </REQUIRES> 

        <KEEPLIST> 

                /usr/bin/hello_world 

        </KEEPLIST> 

</COMPONENT> 

</GROUP> 

If the software package that you are using is subject to a different and 
unique license, the license tag needs to include a bit more 
information to be useful. Suppose that the software package 
hello_world has the following license in it's source somewhere: 

Copyright 2001 Christian Bird 

If hello_world is distributed in source or binary 

form, it must include acknowledgement of the 

author, Christian Bird somewhere visible to the 
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user of your product. 

 

In no way may you claim endorsement from the author 

for any product that includes hello_world in it. 

In order for the License Reporting Wizard to understand this license, 
we need to include the text of the license and some attributes of the 
license. There is currently a list of attributes that a license may have. 
The list is in a table below.

License Attribute Text Displayed in Wizard

acknowledgement_requested Acknowledgement of the authors is 
requested in your product 
documentation 

 cannot_link If you link to this software (either 
statically or dynamically), then the 
terms of this license apply

 give_source If you modify the source or make 
derivative works from it, you need to 
make these changes available to your 
direct customers of this code

 include_license You must include the text of the license 
in your product documentation.

 interactive If your program is interactive, you must 
provide a way for the user to see the 
license.

lineo_license_agreement You need a license agreement with lineo 
in order to use this package

mark_altered_source If you alter the source code, you must 
plainly mark the alterations.

no_endorse You may not claim that the authors of 
this product endorse your package
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These attributes are found in the text file: 
/opt/Embedix/embedix-2.0/wizards/licenses/license_attributes 

You can add any attributes that you would like to this file and then 
include those attributes in the license tag of an ECD. 

For the above license, two attributes stand out. 

! Any use of the package must acknowledge the author.

! Anyone using the software in their product may not claim that 
the author endorses it. 

Thus the two license attributes would be: 

no_endorse=1 

show_acknowledgement_manual=<Author’s Name>

Note that most licenses are much more complex than this simple 
example. It's best to have your legal department inspect the license 
before determining the attributes that apply to the license. If no 

 share_money If you make any money by selling this 
package in your product, the author 
should get some.

share_or_rename You must make your modifications 
available publicly, or rename the 
software to avoid conflict with the 
standard version 

show_acknowledgement_ads You must include acknowledgements of 
the authors if you mention this package 
in any advertisements.

show_acknowledgement_man
ual

You must include acknowledgements of 
the authors in your product 
documentation.

 source_with_binary If you distribute object code or a binary 
then you must include the source code 
as well.

License Attribute Text Displayed in Wizard
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attributes fulfill the needs that you have, feel free to modify the text 
file and add what you do need. 

Usually you will want to just set an attribute equal to 1 (or some non-
zero value), but in the acknowledgement case, you should set it to the 
name of the person or group to acknowledge.(the acknowledgement 
attributes are the only attributes that are handled specially. You 
should set all attributes that apply to the license equal to 1.) 

Attributes are separated from the license text itself by at least 8 
dashes. Thus the whole ECD for hello_world would like something 
like this: 

<GROUP bar> 

<COMPONENT hello_world> 

        <LICENSE> 

no_endorse=1 

show_acknowledgement_manual=Christian Bird 

-------- 

Copyright 2001 Christian Bird 

If hello_world is distributed in source or binary 

form, it must include acknowledgement of the 

author, Christian Bird somewhere visible to the 

user of your product. 

 

In no way may you claim endorsement from the author 

for any product that includes hello_world in it. 

 </LICENSE> 

        TYPE=bool 

        DEFAULT_VALUE=1 

        PROMPT=include hello_world package 

        <HELP> 

        This is hello_world. 

        </HELP> 

        <REQUIRES> 

                libc.so.6 

                ld-linux.so.2 

        </REQUIRES> 

        <KEEPLIST> 

                /usr/bin/hello_world 

        </KEEPLIST> 

</COMPONENT> 

</GROUP> 
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Once you have modified the ECD file for a given package, it will work 
seamlessly with the License Reporting Wizard. In addition, this 
package will automatically take advantage of features planned to be 
included in later releases of the SDK. In the future it might be 
possible to view a package's license in a window pane directly inside 
of Target Wizard. In addition, by adding this license information, the 
software package becomes usable by the Library Checking Wizard, 
another tool in the Embedix GPL Compliance Toolset.
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C H A P T E R 4 License Compliance Interview
The License Compliance Interview, like the other tools in this 
product, is accessed through the Embedix™ Target Wizard File 
menu. This chapter includes the following sections:

“Introduction” on page 31
“Starting a License Compliance Interview” on page 32
“Interview: Part I—Software” on page 35
“Interview: Part II—Practices” on page 39

Introduction
For every Linux product or project that you produce, we recommend 
that the following people complete the License Compliance 
Interview:

! At least one policy maker (like a manager or executive). 

! Every development engineer who helped develop this product.

There are two main sections to the License Compliance Interview: (1) 
the Software Interview and (2) the Practices Interview.

Software Interview

The software interview begins by having you name pieces of software 
in your product or project and add the names to a list. Then, for every 
software name in the list, you are given the opportunity to answer a 
series of questions regarding:

! Software authorship.

! Whether or not it is a derivative of another piece and, if so, the 
authorship of the base work.
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! Linkage, if any.

! Intended license.

Each time you complete a question series for a piece of software, an 
asterisk is placed next to the software name in the list, helping you 
keep track of which portions of the interview you have completed. 

When you choose to save your interview to the interview database 
(which is not the same as saving it to a report), you can return to the 
portion of the interview you last touched and either continue with 
your responses or edit previous responses.

Practices Interview

The Practices Interview focuses on general development activities in 
which your company engages to help identify practices that may 
create legal obligations for you.

Saving Interview Results to a File or Database

Throughout the interview you are provided opportunities to:

! Save a report to a file: 
Especially useful when you need to forward your report to 
another person or archive your report. 

! Save your answers to a database: 
Especially useful when you want to complete your interview in 
stages. When you choose to save the database, a file named 
interview.dbm is saved in your current directory. 

The next time you start the License Compliance Interview, you 
can click the LOAD button on the Introduction page (when 
available) to jump to your interview in progress.

Starting a License Compliance Interview
The tool supports multiple interviews, but is limited to one interview 
database per directory (the database is named interview.dbm). In 
order to complete an interview for a particular project, change to 
your project directory prior to starting Target Wizard.
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To start the License Compliance Interview for your project: 

1. Change to your project directory. For example, you might enter:

cd /<project_directoryproject_directoryproject_directoryproject_directory>

2. Start Target Wizard.

3. From the menu bar, choose File > Run Wizard.

A dialog box appears with a list of wizards. 

4. Highlight License Compliance Interview and then click RUN. 

The first page of the License Interview Wizard appears. 

5. If you would like to resume an interview in progress, click LOAD 
and then skip ahead as needed.

Warning:  You are allowed only one interview database per 
directory (the database is named interview.dbm). If you have 
started an interview in this directory and you don’t click 
LOAD, you will overwrite the previous interview.

6. If this is your first interview, click NEXT. 

The Enter Information page appears.
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7. Enter your name and the name of your project, then click NEXT. 

The Select Interview Sections page appears.

8. Select one or both of the interview sections and then click NEXT.
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Interview: Part I�Software
If you indicated that you would like to complete the software 
interview, the following page appears. 

1. From the Identification of Software Pieces page, click NEXT.

The following page appears.

2. Build a list of software to evaluate.

2a. Choose Add an Item and then click NEXT.

The following page appears.
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2b. On the Add a Software Item page, enter a software name for 
each distinct piece of software in your project and then click 
NEXT.

The name does not need to be a filename. It can be any 
working title that clearly identifies that software piece.

With each successful entry, your page refreshes to display the 
latest entry in the list.

2c. When you are finished building your list, choose Done 
Adding Items and then click NEXT.
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The following page appears.

3. To evaluate a piece of software in the list, highlight the list item 
and then click NEXT.

You can choose to evaluate the list items in any order. Once a list 
item has been evaluated, it is flagged in the list with an asterisk. 
At a glance which ones you have completed and which ones you 
still need to do.

Note:  The next several pages that appear apply specifically 
to the software piece you chose in Step 3. 

4. Follow the screen prompts to complete the portion of the 
interview specifically related to your chosen piece of software.

You will essentially complete a series of questions related to the 
list item, as described in “Software Interview” on page 31.

When you complete the interview series for your chosen piece of 
software, a page similar to the following page appears.
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5. (Optional) Click SAVE before continuing.

If you choose to save now and exit the wizard, you can continue 
the interview at a later time by choosing the LOAD button the 
next time you start this wizard.

You might also choose SAVE now just to save your answers up 
to this point before moving on to another section of the 
interview.

6. Choose an answer to the question “Continue the software 
portion of the interview?” and then click NEXT.

6a. To complete the survey questions for another piece of 
software in your list, choose “Yes—Continue...” and then 
follow the screen prompts until you are returned to the 
previous screen.

6b. To proceed to the Practices portion of the interview, choose 
“No—Proceed with other parts...” and then refer to the next 
section, “Interview: Part II—Practices” on page 39.

6c. To view the results of the interview completed on the last list 
item, choose “No—View the results...” and then view the 
results before proceeding.

This provides a quick preview of your responses for this 
software item. You may want to do this to gain a better 
understand of how your responses are being used.
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Interview: Part II�Practices
If you indicated that you would like to complete the Practices 
Interview, the following page appears.

1. Follow the prompts on each page to complete the Practices 
Interview. 

When you complete the “Practices” portion of the interview, the 
following page appears.

2. To complete the analysis and view the results, click NEXT.
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A page similar to the following page appears.

3. When you are finished viewing the results, click NEXT.

You are given the opportunity to save the results to a file on the 
following page.

4. On the Save Report page, indicate if and how you want to save 
the report and then click NEXT. 

If you want to save the report to a file, enable the Write report to 
a file and then give your report a name.
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The Finish page appears.

5. Read the Finish page for tips that might save you time on your 
next interview session.

Warning:  Saving a report and saving your interview 
responses are not the same thing. Saving a report saves your 
interview results to a text file (which is static). Saving your 
interview saves your responses to a database (which is 
dynamic). If you intend to return to this interview and edit 
your responses or resume the interview, then click SAVE.

6. To save your interview database to your current directory, click 
SAVE. 

7. To exit the License Compliance Interview, click FINISH.

Resuming an Interview in Progress
To resume a License Compliance Interview in progress: 

1. Open a terminal emulation window and then change to the 
directory where you saved your last interview by entering the 
following command:
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cd /<directory_with_interview.dbm_filedirectory_with_interview.dbm_filedirectory_with_interview.dbm_filedirectory_with_interview.dbm_file>

2. Start Target Wizard.

3. From the menu bar, choose File > Run Wizard.

A dialog box appears with a list of wizards. 

4. Highlight License Compliance Interview and then click RUN. 

The first page of the License Compliance Interview Wizard 
appears. 

5. If you would like to resume an interview in progress, click 
LOAD.

Warning:  You are allowed only one interview database per 
directory (the database is named interview.dbm). If you have 
started an interview in this directory and you don’t click 
LOAD, you will overwrite the previous interview.

For guidelines in completing the remaining pages in this 
interview, refer to “Interview: Part I—Software” on page 35 or 
“Interview: Part II—Practices” on page 39.
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